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Cells

This section teaches you how to configure the cells on your template for electronic data entr
You’ll also learn about the Cell palette—a convenient feature that provides quick access to 
Informed Designer’s cell settings. By the end of this section, you’ll know how to perform to the
lowing tasks:

■  show and hide the Cell palette

■  set the name, type, and format of a cell

■  set data entry options for cells

■  create a help message

■  add scroll bars to fields.

Overview
When you draw a form template with Informed Designer, you use the Field and Table tools to
ate the blanks where information is typed. These “blanks” are called cells.

When a template is used with Informed Filler, the user fills out the form by entering informati
such as a name, number, date, or time into each cell. As the form designer, you have a great
control over the type of information each cell will hold, as well as how that information will be
played.

Each cell has its own individual attributes including a cell name, a cell type, and various forma
options. You configure these attributes using Informed Designer’s Cell and Format command

Overview
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Naming a Cell
Informed Designer automatically names cells according to the sequence in which the cells a
drawn. For example, the first cell you draw is named “Cell1.” The next cell you draw is named
“Cell2” and so on.

You can give a cell a descriptive name to make it easier to find when adding intelligence to th
form. For example, a cell named “Total” is much easier to recognize than a cell named “Cell2

In this exercise you’ll use both the Cell command and the Cell palette to assign descriptive n
to the cells on your template.

■  Select the Purchase Order Number field by clicking it once with the Pointer tool.

■  Choose Cell... from the Settings menu or click the Cell button on the Cell palette to display
Cell Settings dialog box.

■  Type PO Number in the ‘Cell Name’ text box, then click ‘OK.’ The cell section of the Purchase 
Order Number field now shows the new cell name.

Naming a Cell

Note Naming a cell is NOT the same as changing the text in the title area of the field. The field tit
intended to be a visual clue to show the user what to enter in a particular field. The cell nam
used to identify the cell in calculation formulas.

Original cell name New cell name



 

Cells 9-3

 .
 .

 .

  

 the 

            

box. 

    

).

      

 form 

      

 F2/

    

Designer Basics  Page 3  Tuesday, May 5, 1998  5:00 PM
.

Naming Cells with the Cell Palette

If you have to rename a number of cells, the Cell palette provides a quick alternative to using
Cell command.

■  Choose Cell Palette from the Show submenu under the Layout menu.

■  The Cell palette appears, showing the name of the currently selected cell.

■  Select the Supplier Name and Address field by clicking it with the Pointer tool.

■  Press F2 (Windows) or Command-Tab (Mac OS) to activate the Cell palette’s ‘Name’ text 

■  Type Supplier in the ‘Name’ text box, then press F2 (Windows) or Command-Tab (Mac OS

Pressing F2 or Command-Tab performs three actions:

■  updates the cell name on the template

■  selects the next cell in the tab order* (Cell3)

■  automatically activates the ‘Name’ text box again.

*The tab order is the order that the Informed Filler user tabs from one cell to the next when a
is filled out. See “Tab Order” on page 10-1 for more information.

■  Type Bill To in the ‘Name’ text box, then press F2/Command-Tab to select Cell4.

■  Repeat this procedure to rename the cells as shown in the following table. Do NOT press
Command-Tab after changing the name of Cell9.

Cell Names
Original Name New Name

Cell4 Ship To

Cell5 Ship Via

Cell6 Instructions

Cell7 Signature

Cell8 Date

Cell9 Total
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Because of the current tab order of your form, pressing F2/Command-Tab after renaming Ce
would take you to the Purchase Details table. The F2/Command-Tab feature is not available
table cells, so you’ll skip the table cells for the moment and rename all other cells first.

■  Select the Yes checkbox field with the Pointer tool, then press F2/Command-Tab to activate
‘Name’ text box on the Cell palette.

■  Type Yes, then press F2/Command-Tab to select Cell15.

■  Rename the cells as shown in the following table. Do NOT press F2/Command-Tab after c
ing the name of Cell16.

Cell Names (continued)

Use the Pointer tool and the Cell command to rename the table cells on your template.

■  Click the table once to select the entire object.

■  Click again in the Qty column to select its cell section (Cell10).

■  Choose Cell... from the Settings menu to display the Cell Settings dialog box.

■  Type Qty in the ‘Cell Name’ text box, then click ‘OK.’

■  Repeat this procedure to rename the remaining table cells as follows:

Table Cell Names

Original Name New Name

Cell15 No

Cell16 Phone

Original Name New Name

Cell11 Description

Cell12 Unit Cost

Cell13 Extended
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Setting the Cell Type
Informed Designer allows you to set a cell’s type so that it matches the kind of information tha
cell is intended to hold. For example, if a cell is intended to hold a number value, then its typ
should be Number. Setting a cell’s type ensures that only entries of the correct type will be al

In addition to setting a cell’s type, you can also control the way that the information in the cel
displayed by specifying a particular format. For example, you can set the format of a Numbe
so that entries are always displayed with a currency symbol and two decimal places.

In this exercise, you’ll use the Format command to set the cell type and formatting options for
cell on your template.

■  Select the Date cell with the Pointer tool.

■  Choose Format... from the Settings menu or click the Format button on the Cell palette.

■  Select ‘Date’ from the ‘Type’ drop-down list, then double-click the ‘Mon D, YYYY’ format in
the ‘Common Date Formats’ scrolling list.

■  Test the date format by typing 9/5/97 in the ‘Test Value’ text box. The ‘Formatted Value’ show
how the date will look when displayed on your form.

■  Click ‘OK’ to return to the drawing window.

Formatting Multiple Cells

When several cells have the same type and format you can format them all together. To do th
down the Shift key and select the desired cells with the Pointer tool, then choose the Format
mand. The changes you make on the Format dialog box will affect all the selected cells.

Setting the Cell Type
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■  Set the type for each cell as shown in the table below. Select and format multiple cells whe
possible.

Cell Types and Formats

* The Signature cell can be configured to hold a digital signature by setting its cell type to
‘Signature.’ However, Informed’s support for digital signature technology is an advanced feat
and is not covered in this tutorial. For detailed information about Signature cells and using di
signatures, see Chapter 2 of your Informed Designer Forms Automation manual.

Type Options

In addition to the formatting options available on the Format dialog box, you can also use a c
type settings to control the way data is displayed. Like field title sections, cells have font, font
type style, and alignment attributes that can be set individually.

■  Select the PO Number cell by clicking it twice with the Pointer tool. A “shimmering” border 
inside the cell section indicates that it is selected.

■  Use the Type command or the Font, Size, and Style submenus to set the cell’s type attrib
Times, 18 point, Bold, Center-aligned (vertical and horizontal).

Cell Name Cell Type Format/Display Options

PO Number Number General

Qty Number General

Signature* Text (default) None (default)

Phone Boolean On/Off

Yes Boolean On/Off

No Boolean On/Off

Unit Cost Number #,##0.00

Extended Number #,##0.00

Total Number #,##0.00

Note Whenever you create a new field, the cell type is automatically set to ‘Text’ with no formatti
Any cells not listed in the above table use this default type and format. You do not need to 
change their settings.

Note When changing the type settings for a cell, make sure that you select only the cell section 
not the entire field object, otherwise, your changes will also affect the field title section.
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Use the same technique set the type attributes for each cell shown in the table below. Reme
select the only the cell section, not the entire field, when you set these type attributes.

Setting Data Entry Options
On a paper form, problems sometimes occur when the person filling out the form forgets to fi
crucial parts of the form. Informed Designer provides data entry controls to avoid these prob
on your template.

You can specify a cell’s entry status to be optional, recommended, or required. In this exercis
you’ll set the data entry status for the Ship Via cell.

■  Select the Ship Via cell by clicking it twice with the Pointer tool.

■  Choose Cell... from the Settings menu to display the Cell Settings dialog box.

■  Select ‘Required’ from the ‘Entry is’ drop-down list.

■  Click ‘OK.’

Cell Name Font Font Size Alignment

Supplier Times 12 point Left (horizontal), Top (vertical) 

Bill To Times 12 point Left (horizontal), Top (vertical) 

Ship To Times 12 point Left (horizontal), Top (vertical) 

Ship Via Times 12 point Left (horizontal), Top (vertical) 

Yes Times 12 point Center (horizontal and vertical)

No Times 12 point Center (horizontal and vertical)

Phone Times 12 point Center (horizontal and vertical)

Instructions Times 12 point Left (horizontal), Top (vertical) 

Qty Times 12 point Center (horizontal and vertical)

Description Times 12 point Left (horizontal), Center (vertical) 

Unit Cost Times 12 point Right (horizontal), Center (vertical)

Extended Times 12 point Right (horizontal), Center (vertical)

Signature Times 12 point Left (horizontal), Top (vertical) 

Date Times 12 point Left (horizontal), Top (vertical) 

Total Times 12 point Right (horizontal), Center (vertical)

Setting Data Entry Options
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Creating a Help Message
Help messages can be very beneficial for Informed Filler users who are using a form for the 
time. For example, users might not be familiar with certain terminology on the form and migh
require some clarification.

In the last exercise, you set the data entry status of the Ship Via cell to ‘Required.’ Leaving that cell 
blank will prompt Informed Filler to display a warning message. It’s possible that a new user m
not understand what type of value they should enter in the Ship Via cell, so in this exercise, you’ll 
create a help message for that cell.

■  If it’s not already selected, select the Ship Via cell with the Pointer tool.

■  Choose Help Message... from the Settings menu or click the ‘Help Message’ button on the C
palette to display the Help Message dialog box.

■  Type the following help message in the text box on the Help Message dialog box:

This field contains a choice list. Click the ÔArrowÕ indicator in the field title section and 
select an entry from the available choices.

■  Click ‘OK’ to return to the drawing window.

Adding a Scroll Bar
To make sure the Informed Filler user has enough room to enter information in a cell, you ca
scroll bars to your fields and tables. This allows the user to enter more data than will fit in the
ble area of the cell section.

Note When designing forms for your organization, exercise caution before using the ‘Required’ e
setting for any cells on your template. This setting ensures that a form cannot be processed
the ‘Required’ cells are filled out, but this might not always be appropriate. For example, do
users fill out the entire form at one sitting? If not, and you have included ‘Required’ fields, th
will not be able to save their work over night.

Creating a Help Message

Adding a Scroll Bar
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In this exercise, you’ll add a scroll bar to the Instructions field on your template.

■  Select the Instructions field by clicking it with the Pointer tool.

■  Choose Field... from the Settings menu to display the Field Settings dialog box.

■  Click the ‘Include scroll bar’ option.

■  Make sure the ‘Show always’ option is turned off.

■  Click ‘OK.’

When the Informed Filler user fills out the purchase order and tabs into the Instructions field, the 
scroll bar will appear at the right edge of the field.

When a field is scrollable, the Informed Filler user can enter more data than will fit in the visi
area of the cell section. When a table is scrollable, Informed Filler automatically adds new ro
the table as the user enters more data than the table can display.

Making Table Rows Expandable
In addition to adding scroll bars, you can also make table rows expand automatically to accep
tional data. With the ‘Expandable rows’ option turned on, the Informed Filler user can enter m
data than the chosen row spacing can display. As data is entered, the selected row expands 
ically to accept the extra information.

Making Table Rows Expandable

The scroll bar appears automatically
when the user tabs into the field.
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In this exercise, you’ll turn on the ‘Expandable rows’ option for the table.

■  Select the table by clicking it once with the Pointer tool.

■  Choose Table... from the Settings menu to display the Table Settings dialog box.

■  Click the ‘Expandable rows’ option, then click ‘OK.’

■  Choose Save from the File menu to save the changes to your form.

This is the end of the session.

Note If all the rows in a table already contain data, Informed Filler will not allow the user to expa
any rows in the table, since doing so would cause the last row of the table to disappear.

The row containing extra data
expands, while the other rows
retain their original spacing.
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